CIS200 MS Access Project Supplement
(NOTE: NOT the main assignment file!! See the MS Access Project file.)

1. Make sure you thoroughly read the main assignment file, Access_Project.pdf. Keep this document
open/available nearby for reference.
Finish the data model, determining which foreign keys are needed:

% = Unique Identifiers
(become the primary

keys in your lables)

= One to Many
Relationship

3. Based on the completed data model, create your tables in MS Access. Create the Class table last.
Make sure you save your tables as labeled in the data model (tblEmployee, thiICustomer, tbiCourse,
and tbiClass). Use Design View to create and set up your fields, selecting the proper data types.

Home — Create Field Name Data Type Field Name | Data Type
#* courselD AutoNumber B custip| AutoMumber
% ? _:\ CourseMame Short Text | CustLName Short Text
View Primary  Euilder CourseType Short Text : CustFName Short Text
(&) CourseDescription Long Text CustAddress Short Text
| | custCity Short Text
| [F0] vatasheet View | || Custstate Short Text
® CustZipCode Short Text
.'.:é: Design View Field Name Data Type : CustPhone Short Text
P EmpID| AutoNumber CustEmail Short Text
| | EmpLName Short Text
| | EmpFName Short Text
| EmpPosition  Short Text
| EmpPhone Short Text
EmpEmail Short Text
. NOTE: The foreign keys (FK_???) are
Field Name | Data Type
 ClassiD| AutoNumber wrong as shown. You must set up the
| ClassDate Date/Time foreign keys based on the data model.
| ClassStartTime Date/Time
| ClassEndTime Date/Time Make sure to select the proper data
ClassLocation  Short Text type for each field.
| || FE_77? Number
| | FK_??? Number Primary keys: AutoNumber
PR e Number Foreign keys: Number




4. Where appropriate, use input masks for your fields.

Field Properties

General |gokup

Field Size 50

Format

Input Mask DDDDD’\.-E?EBE';;J
Caption

[ T Y FAL WS

Input Mask Wizard

Which input mask matches how you want data to look?

To see how a selected mask works, use the Try It box.

To change the Input Mask list, dick the Edit List button.

Input Mask: Data Look:

S ——

Sodal Security Mumber 2831-86-7180

Zip Code 93052-63599

Extension 63215

Password ~ |FEEEEEE

Long Time 1:12:00 PM v

Try It: |

Edit List Cancel Einish

5. Save your tables as labeled in the data model (tblEmployee, thiICustomer, tblCourse, and tbiClass).

6. Create relationships between the tables by going to Database Tools (tab) = Relationships.

7. Inthe Relationships window, select all tables using the Shift key and selecting all tables.

Show Table ? >
Tables  Queries  Both
thiClass
thiCourse
thiCustomer
thiIEmployvee
H au 14
8. Click “Add
9. Drag and drop to rearrange the tables.
thlEmployee thiClass thiCourse
? EmpID 7 ClassiD 7 CourselD
EmpLMame ClassDate CourseMame
EmpFName ClassStartTime CourseType
EmpPasition ClassEndTime CourseDescription
EmpPhone ClassLocation
EmpEmail FK_EmpID
FE_CourselD
FK_CustiD

thlCustomer

% CustiD -

CustlMame
CustFMName
CustAddress
CustCity

CustState -




10. Drag and drop from the PK to the corresponding FK to create a relationship.

thlEmployee thiClass thlCourse
# EmplD ? ClassiD # CourselD
EmpLMName ClassDate CourseMame
EmpFMame ClassStartTime CourseType
EmpPaosition ClassEndTime CourseDescription
EmpPhone ClassLocation
EmpEmail FE_EmpID
FE_CourselD
FK_CustiD
thlCustomer
% CcustiD -
CustLMame
CustFMame
CustAddress
CustCity
CustState -

11. Make sure to select “Enforce Referential Integrity” when you create relationships.

Edit Relationships 7 *
Table/Query: Related Table/Query:
thIEmployee thiClass
Cancel

EmplD ~ | FK_EmplD ~
Join Type..

]
Create New..

Enforce Referential Integrity
[] cascade Update Related Fields
[ cascade Delete Related Records

Relationship Type: One-To-Many

12. When you are finished creating relationships, they should look as follows:

thlEmployee

% EmpID
EmpLMame
EmpFMame
EmpPosition
EmpPhone
EmpEmail

tblClass

¥ ClassiD
ClassDate

FE_EmplD

ClassStartTime
ClassEndTime
ClassLocation

FK_CourselD
FE_CustlD

thlCourse

¥ CourselD
CourseMName
CourseType
CourseDescription

=

thICustomer

¥ CustiD
CustLMName
CustFMame
CustAddress
CustCity
CustState

13. Close the Relationships window and SAVE the layout of the relationships.




Now you are ready to enter data, and you will do this using forms.

14. Click on the table for which you are creating a form. For every table, there will be a corresponding
form, and you will create one form at a time.

15. Go to the Create tab and select Form Wizard.

16. Click the double arrows to select all fields.

Form Wizard
Which fields do you want on your form?

You can choose from more than one table or query.

Tables/Queries

Table: thiCustomer v

Available Fields: Selected Fields:

B
CustLName
CustFName
CustAddress
CustCity
CustState
CustZipCode
CustPhone
CuctEmail

>

>>

Cancel Next > Finish

17. Click “Next” and select the layout you want.
18. Click “Next” and relabel the form with the prefix “frm” (e.g., frmCustomer).
19. Click “Finish” and repeat these steps until a form is created for each table.

20. Use the forms to enter data into the tables. (If you happened to have already entered data directly
into the tables, the data should populate in the forms.)
a. Enter data in the Class form LAST.

b. You should enter at least five records for Employee, Course, and Customer.
c. You should enter at least ten records for Class.

21. In the Class form, for the FK fields, you will need to enter the numbers that correspond with the IDs
of the employees, customers, and courses. This is why you enter data into the Class form/table last.
a. For example, if the PK_EmployeelD for Luca Felton is 1, if Luca Felton is to teach a class, you

will enter 1 in the FK_EmployeelD field for the class she is teaching. You do the same to enter

FK data for Customer and Course per class record.
b. Look ahead to the queries (Access_Project.pdf) to make sure your data entry can be used for
the queries.

22. Save all of your data entry. Once you are finished with the data entry, you can move on to the
queries.



NOTE: Remember that we perform queries to retrieve meaningful information, so you want to include
fields in your queries that represent meaningful information. It’s fine if you include IDs but you will also
want names and course titles/names, so you can make better sense of the information retrieved.

23. To create a query, go to the Create tab and select “Query Design.”

24. Select all tables using the Shift key and selecting all tables.

Show Table ? x>

Tables  Queries Both

thiClass
thlCourse
thlCustomer
thIEmployes

25. Click “Add.” The tables should appear with the relationships linking the tables.

26. For Query 1, drag and drop the field names from the tables to the field row at the bottom of the
screen.

= Queryl

thiClass thiCourse thiCustomer thlEmplayee

? ClassiD - B ‘ - . -
ClassDate F| P coursed e > T EmpD

EmpLName

EmpFMame

EmpPasition

ClassStartTime CourseName
ClassEndTime ! CeourseType

ClassLacation CaurseDescription

FK_EmpID
FK CourselD TIET

EmpPhone

EmoEmail

Fielek | CourseName ClassDate
Table: tbiCourse thiclazs

Sort:
Show: |

Criteria,

27. Click “Run”

ClassStartTime
thiclass thlClass thiclass

ClassEndTime Classlocation

to run the query.

EmpFhlam EmpLiame CustfName CustlMame
thlEmplayee thlEmployee tbiCustomer thiCustomer

(=) =)

28. Check the results to ensure the query returned the information needed.

29. Save the query according to the assignment instructions (qryl). When you close the query window,
you will be prompted to save the query.



Starting with Query 2, specific criteria are required for the queries. The next step will demonstrate how
to create Query 4, which is the most complex query. With this knowledge, you should be able to create
Queries 2 and 3.

30. Query 4 asks, “What classes are being led by either Anya Shumer or Ramon Tucker in March 2019?”
In this query, you need to enter criteria on the lower portion of the Query Design screen to return
information that only includes these two instructors teaching in March 2019 (but, before you try this,
read further to learn why the below criteria can be improved).

thlClass
thlEmploy
tblCourse x mployee
* = ¥ ClassiD L o
% CourselD g ClassDate # EmpiD
CourseName ClassStartTime Emplastilame
CourseType ClassEndTime EmpFirsthame
. EmpPosition
CourseDescription |« ClassLocation p
[+ o)
FK_EmplD EmpFhaone
= FK_CourselD EmpEmail
FK_CustiD
Field: | CourseMame | ClassDate EmpFirstlame EmplastMame
Table: [tblCourse tbiClass thlEmployee tblIEmployee
Sort:
Show:
Criteria: Between #3/1/2019# And #3/31/201%  "Anya” Or "Ramon’ “Shumer” Or "Tucker’
or:

HOWEVER, while the above query will work, technically, the query asks to return information for any
employee with the last names “Shumer” or “Tucker” and first name “Anya” or “Ramon”...so if there is
ever a Ramon Shumer or Anya Tucker, they will be included in the results. To be more precise with the
query, you should use the EmplID field, which will always uniquely identify the employees. See below:

thiClass
thlCourse . thlEmployee
* - ¥ ClassiD . T
¥ CourselD ClassDate # EmpID
CourseMame ClassStartTime EmpLastName
CourseType ClassEndTime EmpFirsthame
CourseDescription | - ClassLocation EmpPosition
FK_EmplID ey EmpPhone
= FK_CourselD EmpEmail
FK_CustiD

Field: | CourseMame ||  ClassDate EmpFirsthame EmplastMame EmplD
Table: |tblCourse tblClass tblEmployee tblEmployee tblEmployee
Sort
Show:
Criteria: Between #£3/1/201% And #3/31/2019# 20r3




31. Click “Run” to run the query.

32. The results appear as follows (NOTE: yours likely will differ because of different data entry):

CourseMame ~ | ClassDate =~ | EmpFirstNar -~ |EmpLastNan - | EmpID -
Bouldering Fundamentals 3 /15/2019 Anya Shumer 2
Introduction to Kayaking 3 /16/2019 Ramon Tucker 3

33. Save the query according to the assignment instructions (qry4). When you close the query window,
you will be prompted to save the query.

34. Create any remaining queries (e.g., Queries 2 and 3) and save them.
35. Next you will create a report based on Query 2. Select gqry2 in the left Access Objects pane.
Quernies

'@ qry1
= anz

36. Select the Create tab - Report Wizard.

External Data Database Tools ' Tell me what you want to do..
— I I — — L S I — = FU"TT Wiidrd -— .
A S| A = A E il L Report Wizard
Table Table SharePoint Query Query Form Form  Blank ' Report Report Blank I
Design  Lists - Wizard Design Design Form [~ | More Forms - Design Report Lot=t

Templates Tables Queries Forms Reporis
I




37. On the Report Wizard window, select all fields by clicking the double arrows.

Report Wizard

Which fields do vou want on your report?

You can choose from mare than one table or query,

Tables/Queries

Query: ary2_MovClasses ~

Available Fields: Selected Fields:

CourseMame
ClaszDate
ClassStartTime
ClassEndTime
EmpFName
EmplLMame
CustFName
CustLName

Cancal Naxt = Finish

38. Click “Next.”

39. When presented with “How do you want to view your data?” select “by tbiClass”

40. Click “Next.”

41. When presented with “Do you want to add any grouping levels?” select “ClassDate” (your “class
date” may look differently depending on how you named this field).

42. Click the single arrow pointing right > to apply “ClassDate” as the grouping level.

Report Wizard

Do you want to add any grouping
levels? ClassDate by Month

CourseMame, ClassDate,
Class5tartTime, ClassEndTime,

Courseiame = ClassLocation, CustFirstMame,
CustlastMame, EmpFirstName,

ClassStartTime EmplastMame

ClassEndTime e

Clazal nration

43. Click “Next.”

44. When presented with “What sort order do you want for detail records?” select “CustLastName”
(your “customer last name” may look differently depending on how you named this field).

45, Click “Next.”



46. Select “Landscape” for Orientation and choose any layout you prefer.

47. Click “Next.”

48. When presented with “What title do you want for your report?” type rptJulyQuery

49, Click “Finish.”

50. On the Home tab, go to View - Design View to format the report.

File Home Create

o Report View
'cts
nj'_')\ Print Preview

Layout View

t'( Design View

51. Once in Design View, you can edit any of the objects by clicking on them. You can resize them,

change the text, move objects around (click and drag), etc.

52. You may wish to use the Format tab to left-justify some text objects or otherwise format the report

content.

53. Here are example before and after views of the report in Design View:
Before/Default:

fﬂ rptlulyQuerg.;

O e T

port H

& ¥

||CusTFir51Name

||EmpFirsTName

: |:N0wt]
# Report Footer

v
You can edit and/or delete field names under “Page Header” only!

"Page " & [Page] & f"&[Pages]|

You can NOT edit any field names under “Detail”! You can move and re-size these ONLY!




After Formatting:

fﬂ rpt) uIyQuerg.;

O N T T - T L - T L T

%

# Page Header

B
# ClassDate Header

¥ Detail

||CIassDate |;|CIassStar‘tTimE|§|ClassEndTim ClassLocation

# Page Footer

: |=N0wt] "Page " & [Page] & " of " & [Pages]

# Report Footer

54. To check the presentation of your report based on your formatting, on the Home tab, go to
View = Report View. You may have to toggle between Report View and Design View several times
before you are satisfied with the formatting.

S 8-

File Home Cre;

j ’A—j‘ B Colors

View | Themes [&] Fonts |

_| Report View

E‘Q Print Preview

== Layout View

b,( Design View

55. Based on the previous before/after views in Design View, the report in Report View appears as
follows:

WildOutfitters July 2019 Classes

Month Course Date Start Time End Time Location Customer Name nstructor Name
July 2019
Basic Caving 7/27/2019 2:00:00 AN 10:50:00 AM In-Store Eliza Arcachon Ramon  Tucker
Intro to Backpacking 7/11/2019 8:30:00 AM 4:00:00 PM  Granite State Park James Eddie Eugene Farley
White Water Rafting 7/11/2019 12:00:00 PM 2:00:00 PM In-Store Sam Walton Emilie  Fields
Mountain Climbing 7/7/2019 9:00:00 AM  12:00:00 PM  Granite State Park Daniel Waterhouse Anya Shumer
Friday, February 15, 2019 Pagelofl

56. Save your report. Once at this step, you have completed the project!

57. Save your Access project according to the file naming instructions specified in Access_Project.pdf and
submit your file Canvas.
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